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NOTICE

© 2000 Sony Electronics Inc. Reproduction in 
whole or in part without written permission is 
prohibited. All rights reserved. This manual and 
the software described herein, in whole or in 
part, may not be reproduced, translated, or 
reduced to any machine-readable form without 
prior written approval.

SONY ELECTRONICS INC. PROVIDES NO 
WARRANTY WITH REGARD TO THIS 
MANUAL, THE SOFTWARE, OR OTHER 
INFORMATION CONTAINED HEREIN AND 
HEREBY EXPRESSLY DISCLAIMS ANY 
IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR 
ANY PARTICULAR PURPOSE WITH 
REGARD TO THIS MANUAL, THE 
SOFTWARE, OR SUCH OTHER 
INFORMATION. IN NO EVENT SHALL 
SONY ELECTRONICS INC. BE LIABLE 
FOR ANY INCIDENTAL, 
CONSEQUENTIAL, OR SPECIAL 
DAMAGES, WHETHER BASED ON TORT, 
CONTRACT, OR OTHERWISE, ARISING 
OUT OF OR IN CONNECTION WITH THIS 
MANUAL, THE SOFTWARE, OR OTHER 
INFORMATION CONTAINED HEREIN OR 
THE USE THEREOF.

Sony Electronics Inc. reserves the right to make 
any modification to this manual or the 
information contained herein at any time 
without notice. The software described herein is 
governed by the terms of a separate user license 
agreement.

This product contains software owned by Sony 
and licensed by third parties. Use of such 
software is subject to the terms and conditions 
of license agreements enclosed with this 
product. Some of the software may not be 
transported or used outside the United States. 
Software specifications are subject to change 
without notice and may not necessarily be 
identical to current retail versions.

Updates and additions to software may require 
an additional charge. Subscriptions to online 
service providers may require a fee and credit 
card information. Financial services may 
require prior arrangements with participating 
financial institutions.

Sony, VAIO, the VAIO logo, VAIO Smart, 
VAIO Slimtop, Media Park, DVgate, Media 
Bar, Handycam, Memory Stick, the Memory 
Stick logo, Movie Shaker, VisualFlow, 
PictureGear and i.LINK are trademarks of 
Sony. Intel and Pentium are trademarks of the 
Intel Corporation. Microsoft, Windows Me, 
Windows, and the Windows logo are registered 
trademarks of Microsoft Corporation. PS/2 is a 
trademark of IBM Corporation.

All other trademarks are trademarks or 
registered trademarks of their respective 
owners.

Owner’s Record

The model number and serial number are 
located on the back of your Sony VAIO 
computer. Record the serial number in the space 
provided here. Refer to the model and serial 
numbers when you call your Sony Service 
Center.

Model Number: PCV-LX700/PCV-LX800

Serial Number:________________________
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Safety Information and 
Caution

❑ To prevent fire or shock hazard, 
do not expose your desktop to 
rain or moisture.To avoid 
electrical shock, do not open the 
cabinet. Refer servicing to 
qualified personnel only.

❑ Never install modem or telephone 
wiring during a lightning storm.

❑ Never install telephone jacks in 
wet locations unless the jack is 
specifically designed for wet 
locations.

❑ Never touch uninsulated 
telephone wire or terminals 
unless the telephone line has been 
disconnected at the network 
interface.

❑ Use caution when installing or 
modifying telephone lines.

❑ Avoid using the modem during an 
electrical storm. 

❑ Do not use the modem or a 
telephone to report a gas leak in 
the vicinity of the leak.

❑ The socket outlet shall be 
installed near the equipment and 
shall be easily accessible.

CD-RW Laser Diode Properties

Laser Output 1.0mW(Read)

35mW (Write)

Wave Length 777–787nm
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❑ Pour prévenir tout risque 
d’incendie ou d’électrocution, 
garder cet appareil à l’abri de la 
pluie et de l’humidité.

❑ Pour prévenir tout risque 
d’électrocution, ne pas ouvrir le 
châssis de cet appareil et ne 
confier son entretien qu’à une 
personne qualifiée.

❑ Ne jamais effectuer l’installation 
de fil modem ou téléphone durant 
un orage électrique.

❑ Ne jamais effectuer l’installation 
d’une prise téléphonique dans un 
endroit mouillé à moins que la 
prise soit conçue à cet effet.

❑ Ne jamais toucher un fil 
téléphonique à découvert ou un 
terminal à moins que la ligne 
téléphonique n’ait été débranché 
de l’interface réseau.

❑ Soyez très prudent lorsque vous 
installez ou modifiez les lignes 
téléphoniques.

❑ Évitez d’utiliser le modem durant 
un orage électrique.

❑ N'utilisez pas le modem ni le 
téléphone pour prévenir d'une 
fuite de gaz vous êtes près de la 
fuite.

❑ L’appareil doit être le plus près 
possible d’une prise murale pour 
en faciliter l’accès.

For questions regarding your product or for the 
Sony Service Center nearest you, call 
1-888-476-6972 in the United States or 
1-800-961-7669 in Canada. 

Sony Customer Support can be reached at 
http://www.sony.com/pcsupport
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Regulatory Information 

This equipment has been tested and found to 
comply with the limits for a Class B digital 
device, pursuant to Part 15 of the Rules. These 
limits are designed to provide reasonable 
protection against harmful interference in a 
residential installation. This equipment 
generates, uses, and can radiate radio frequency 
energy and, if not installed and used in 
accordance with the instructions, may cause 
harmful interference to radio communications. 
However, there is no guarantee that interference 
will not occur in a particular installation. If this 
equipment does cause harmful interference to 
radio or television reception, which can be 
determined by turning the equipment off and 
on, the user is encouraged to try to correct the 

interference by one or more of the following 
measures:

❑ Reorient or relocate the receiving 
antenna.

❑ Increase the separation between 
the equipment and the receiver.

❑ Connect the equipment into an 
outlet on a circuit different from 
that to which the receiver is 
connected.

❑ Consult the dealer or an 
experienced radio/TV technician 
for help. 

You are cautioned that any changes or 
modifications not expressly approved in this 
manual could void your authority to operate this 
equipment. 

Only peripherals (computer input/output 
devices, terminals, printers, etc.) that comply 
with FCC Class B limits may be attached to this 
computer product. Operation with 
noncompliant peripherals is likely to result in 
interference to radio and television reception.

All cables used to connect peripherals must be 
shielded and grounded. Operation with cables, 
connected to peripherals, that are not shielded 
and grounded, may result in interference to 
radio and television reception.

FCC Part 68

This equipment complies with Part 68 of the 
FCC rules. The FCC Ringer Equivalence 
Number (REN) for this equipment is 0.7. 
If requested, this information must be provided 
to the telephone company.

This modem uses the USOC RJ-11 telephone 
jack.

Declaration of Conformity

Trade Name: SONY

Model No.: PCV-LX700

PCV-LX800

Responsible 
Party: 

Sony Electronics Inc.

Address: 1 Sony Drive
Park Ridge, NJ 07656

Telephone: 201-930-6972

This phone number is for FCC-related 
matters only.

This device complies with Part 15 of the 
FCC rules. Operation is subject to the 
following two conditions: 

(1) This device may not cause harmful 
interference, and

(2) this device must accept any interference 
received, including interference that may 
cause undesired operation.
5



VAIO Slimtop™ LCD Computer User Guide
The REN is used to determine the quantity of 
devices which may be connected to the 
telephone line. Excessive RENs on the 
telephone line may result in the devices not 
ringing in response to an incoming call. In 
most, but not all areas, the sum of the RENs 
should not exceed five (5.0). To be certain of 
the number of devices that may be connected to 
the line, as determined by the total RENs, 
contact the telephone company to determine the 
maximum REN for the calling area.

If the terminal equipment causes harm to the 
telephone network, the telephone company will 
notify you in advance that temporary 
discontinuance of service may be required. But 
if advance notice is not practical, the telephone 
company will notify the customer as soon as 
possible. Also, you will be advised of your right 
to file a complaint with the FCC if you believe 
it is necessary.

The telephone company may make changes in 
its facilities, equipment, operations or 
procedures that could affect the operations of 
the equipment. If this happens, the telephone 
company will provide advance notice in order 
for you to make the necessary modifications in 
order to maintain uninterrupted service.

If trouble is experienced with this modem, for 
repair or warranty information, please contact 
1-888-4SONY-PC, or write to the Sony 
Customer Information Center, 12451 Gateway 
Blvd., Fort Myers, FL 33913. If the trouble is 
causing harm to the telephone network, the 
telephone company may request that you 
remove the equipment from the network until 
the problem is resolved.

Repair of this equipment should be made only 
by a Sony Service Center or Sony authorized 
agent. For the Sony Service Center nearest you, 
call 1-888-4SONYPC (1-888-476-6972).

This equipment cannot be used on public coin 
service provided by the telephone company. 
Connection to Party Line Service is subject to 
state and possible provincial tariffs. (Contact 

the state or provincial utility service 
commission, public service commission, or 
corporation commission for information.)

Telephone Consumer 
Protection Act of 1991
(United States)

The Telephone Consumer Protection Act of 
1991 makes it unlawful for any person to use a 
computer or other electronic device to send any 
message via a telephone facsimile machine 
unless such message clearly contains, in a 
margin at the top or bottom of each transmitted 
page or on the first page of the transmission, the 
date and time it is sent and an identification of 
the business, other entity, or individual sending 
the message, and the telephone number of the 
sending machine or such business, other entity, 
or individual.

In order to program this information into your 
facsimile machine, see your fax software 
documentation.

Telephone Consumer 
Guidelines (Canada)

Please refer to your telephone directory under 
‘Privacy Issues’ and/or ‘Terms of Service.’ For 
more detailed information, please contact:

CRTC 
Terrasses de la Chaudiére, Tour centrale
1 promenade du Portage, 5 étage Hull PQ K1A 
0N2.

This Class B digital apparatus complies with 
Canadian ICES-003.

Cet àppareil numérique de la classe B est 
conforme à la norme NMB-003 du Canada.
6



DISPOSAL OF LITHIUM ION 
BATTERY

You can return your unwanted lithium ion 
batteries to your nearest Sony Service Center or 
Factory Service Center.

For the Sony Service Center nearest you, call 
1-888-476-6972 in the United States or 
1-800-961-7669 in Canada.

INDUSTRY CANADA NOTICE

NOTICE: The Industry Canada label identifies 
certified equipment. This certification means 
that the equipment meets certain 
telecommunications network protective, 
operational and safety requirements as 
prescribed in the appropriate Terminal 
Equipment Technical Requirements 
document(s). The Department does not 
guarantee the equipment will operate to the 
user’s satisfaction.

Before installing this equipment, users should 
ensure that it is permissible to be connected to 
the facilities of the local telecommunications 
company. The equipment must also be installed 
using an acceptable method of connection.
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The customer should be aware that compliance 
with the above conditions may not prevent 
degradation of service in some situations.

Repairs to certified equipment should be 
coordinated by a representative designated by 
the supplier. Equipment malfunctions or any 
repairs or alterations made by the user to this 
equipment may give the telecommunications 
company cause to request that the user 
disconnect the equipment.

Users should ensure for their own protection 
that the electrical ground connections of the 
power utility, telephone lines and internal 
metallic water pipe system, if present, are 
connected together. This precaution may be 
particularly important in rural areas.

CAUTION: Users should not attempt to make 
such connections themselves, but should 
contact the appropriate electrical inspection 
authority, or electrician, as appropriate.

NOTICE: The Ringer Equivalence Number 
(REN) assigned to each terminal device 
provides an indication of the maximum number 
of terminals allowed to be connected to a 
telephone interface. The termination on an 
interface may consist of any combination of 
devices subject only to the requirement that the 
sum of the Ringer Equivalence Numbers of all 
the devices does not exceed 5. The Ringer 
Equivalence Number for this equipment is 0.7.

AVIS DE L’INDUSTRIE 
CANADA

AVIS: L’étiquette d’Industrie Canada identifie 
le matériel homologué.

Cette étiquette certifie que le matériel est 
conforme aux normes de protection, 
d’exploitation et de sécurité des réseaux de 
télécommunications, comme le prescrivent les 
documents concernant les exigences techniques 
relatives au matériel terminal. Le Ministère 

n’assure toutefois pas que le matériel 
fonctionnera à la satisfaction de l’utilisateur.

Avant d’installer ce matériel, l’utilisateur doit 
s’assurer qu’il est permis de le raccorder aux 
installations de l’entreprise locale de 
télécommunication. Le matériel doit également 
être installé en suivant une méthode acceptée de 
raccordement. L’abonné ne doit pas oublier 
qu’il est possible que la conformité aux 
conditions énoncées ci-dessus n’empêche pas la 
dégradation du service dans certaines 
situations.

Les réparations de  matériel homologué doivent 
être coordonnées par un représentant désigné 
par le fournisseur. L’entreprise de 
télécommunications peut demander à 
l’utilisateur de débrancher un appareil à la suite 
de réparations ou de modifications effectuées 
par l’utilisateur ou à cause de mauvais 
fonctionnement.

Pour sa propre protection, l’utilisateur doit 
s’assurer que tous les fils de mise à la terre de la 
source d’énergie électrique, des lignes 
téléphoniques et des canalisations d’eau 
métalliques, s’il y en a, sont raccordés 
ensemble. Cette précaution est particulièrement 
importante dans les régions rurales.

Avertissement: L’utilisateur ne doit pas tenter 
de faire ces raccordements lui-même; il doit 
avoir recours à un service d’inspection des 
installations électriques, ou à un électricien, 
selon le cas.

AVIS: L’indice d’équivalence de la sonnerie 
(IES) assigné à chaque dispositif terminal 
indique le nombre maximal de terminaux qui 
peuvent être raccordés à une interface.

La terminaison d’une interface téléphonique 
peut consister en une combination de quelques 
dispositifs, à la seule condition que la somme 
d’indices d’équivalence de la sonnerie de tous 
les dispositifs n’excède pas 5. L’indice 
d’équivalence de la sonnerie de ce matériel est 
de 0.7.
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Welcome
Thank you for purchasing your Sony VAIO Slimtop™ LCD computer! Your new 
computer is a superb blend of high technology and easy-to-use functionality. This 
User Guide contains information about the applications included with your 
system, contact information for software vendors, and the specifications for your 
computer.

Choosing an Ergonomic Location 
for Your Computer
Before you get started, find the best location for your new computer. Here are 
some things to consider when planning your workspace:

❑ Stable work surface — Use a stable work surface large enough to support 
the computer and other equipment.

❑ Ventilation — Leave at least eight inches of space on the left and back sides 
of your computer to enable proper ventilation.

❑ Placement of the keyboard, mouse, and other input devices — Place 
your keyboard, mouse, and other input devices so that your arms and hands 
are in a relaxed, comfortable position. The keyboard should be directly in 
front of you. Adjust the level of the keyboard so that your lower arms are 
parallel to the floor. Keep your wrists in a relaxed position when you are 
using the keyboard—not angled up or down. Use the palmrest only briefly, 
for resting. While typing, never use the palmrest or rest your hands on the 
table. Position the mouse at the same level as the keyboard. Hold the mouse 
with a relaxed hand, and use your whole arm to move it. Take breaks during 
sessions with your computer. Excessive use of the mouse or a joystick may 
strain muscles or tendons.

❑ Furniture and posture — Sit in a chair with good back support and 
armrests. Adjust the level of the chair so your feet are flat on the floor. 
A footrest may make you more comfortable. Sit with relaxed, upright 
posture—avoid slouching forward or leaning far backward.
11
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❑ Viewing angle of the display — Position the display 18 to 26 inches 
directly in front of you, with the top of the screen at or a little below eye 
level. Use the display’s tilting feature to find the best position. You can 
reduce eye strain and muscle fatigue by placing the display in the proper 
position.

❑ Lighting — Choose a location where windows and lights do not create glare 
and reflection on the display. Use indirect lighting to avoid bright spots on 
the display. You can also purchase accessories for your display that help 
reduce glare. Proper lighting adds to your comfort and work effectiveness.

Front Panel Overview
The front panel of your VAIO Slimtop™ Computer allows for access to the 
CD-RW drive. It also includes Universal Serial Bus (USB) and i.LINK® ports to 
connect USB devices, digital equipment, or other components.
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Front Panel Overview
Locating Controls and Connectors

Front Panel (PCV-LX700/PCV-LX800)

� �������	�
���
����

Ejects a disc from the CD-RW drive.

� �����������

Reads data from a CD and writes data to a CD-R or CD-RW disc.

� ���������������

�  �����
�����!�"#�

Lights in amber while reading and writing data from and to a Memory Stick 
media.

$ %������ &��������

�  �����
�����!�"#�

Lights in amber while reading and writing data from and to the hard disk.

OPEN/CLOSE

MEMORY
STICK

HD

DISC
13
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' �������������

�  �����
�����!�"#�

Lights in amber while reading and writing data from and to a CD-R or CD-
RW disc.

( )�*��� *��
#���������
�����!�"#�

Turns on/off the computer and the display. The indicator light is green while 
the power is on and amber when the computer is in standby mode.

+ ,�����-���!�
����

A sliding panel that covers the PC card slot, Memory Stick slot, and 
connectors.
14



Front Panel Overview
PCV-LX700/PCV-LX800 Front Panel (cont.)

. )������� !��

A PC card (also called a PCMCIA card) can be installed in this slot. PC cards 
enable you to add functionality to your system.

/ ��������������0����� !��

Insert a Sony MEMORY STICK card into this slot.

�1 �2����� �!������!�3
 �42�35�
����
���

Connects a USB device.

�� �67�8��$�-���
����
����4������/$5

Connects a compatible digital device such as a Sony Digital Handycam® 
Camcorder.

OPEN/CLOSE

MEMORY
STICK

M
E

M
O

R
Y

S
T

IC
K

U
S

B
i.L

IN
K

 S
40

0

HD

P
C

 C
A

R
D

DISC
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Back Panel Overview
The back panel of your computer contains the connectors for supplied and 
optional accessories. The icons on the back panel help locate and identify the 
connectors on your computer.

Locating Controls and Connectors

Back Panel (PCV-LX700/PCV-LX800)

�� 9����-
��
����
���

Connects the supplied power cord.

� ��7����

A handle that is used to remove the unit cover.

�� ��������
����
���

Connects a standard CRT display.

M
O

N
ITO

R

M
IC

P
H

O
N

E
S

N
E

T
W

O
R

K
/U

S
B

L
IN

E
 IN

i.L
IN

K
 S

400
L

C
D

LINE
PHO

NE
U

S
B
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Back Panel Overview
$ ��%��8���
����
���

10Base-T/100Base-TX Fast Ethernet interface.
The connector marked with (Network) is for LAN connections only.

' 2����� �!������!�3
 �42�35�
����
��� �4�5

Connects a USB device. Three USB connectors are located on the back panel. 
One USB is located on the modem card (see #13).

(� %���-#��� �
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Connects optional headphones or computer speakers.

+ 7�������
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���

Connects an audio device.

. ���
��-#���������
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Connects a microphone(optional).

/ �67�8���(�-���
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Connects a compatible digital device such as a Sony Digital Handycam® 
Camcorder. 

�1 7���0�������4�� -!�:5�
����
���

Connects the VAIO Slimtop™ LCD monitor to the computer.
Note: Do not connect any other display to this connector other than the LCD 
monitor that is supplied with this system.

�� �7����	�
&

Connects the supplied modem cable to the wall jack.

�� ��!�-#����
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Connects the phone cable to the computer.
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Connects a USB device.

✍ 
������
����
	�����	��������������������
�����
���
��
��
����	����
����
�
������
������� �������
�	��!����	����
��"

�����
������������
�	�������
�������
��
��"

��
������
��	�
17



VAIO Slimtop™ LCD Computer User Guide
LCD Overview
Your VAIO Slimtop Computer is supplied with an LCD monitor. The 
PCV-LX800 is supplied with a QVGA (1280 x 960), and the PCV-LX700 is 
supplied with a XGA (1024 x 768).

LCD Monitor

� �)�*�������
�����!�"#�

Light is green while the power is on. When the computer enters standby mode, 
this indicator light turns amber.

�� ���;��0������7��

Light turns red to alert the user to activities, such as the arrival of e-mail. 
See “AutoAlert E-mail Notification System” .

�� �3��"#���  �
�����!

Adjusts the brightness of the screen.

$� �<�!
0��
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Adjusts the volume of the integrated speakers on the LCD display.

USB
M
O
USE
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LCD Overview
 Adjusting the LCD display

1 Holding both sides of the display, push the display panel out and up.

2 Set the display height so that it does not touch the keyboard, and adjust the 
viewing angle approximately 27 degrees from eye level to the center of the 
screen.

' ��
 �������
���

Connects a PS/2 mouse.

( 2����� �!������!�3
 �42�35�
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Connects a USB device.

+ )�=�����:������
����
���

Connects a VAIO Convertible Keyboard.

Adjusting the Height and Viewing Angle of the Display

Adjusting Viewing Angle
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VAIO® Action Setup
VAIO Action Setup manages the settings for your computer's Programmable 
Power Keys (PPK), internal timer, i.LINK® interface, and Memory Stick® 
media. An overview of each of these functions is provided below. For more 
information on changing these settings using VAIO Action Setup, see the online 
VAIO Action Setup Help files. 

����

�  �<9���9
��������
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1 Click Start, point to Programs, and then point to VAIO Action Setup. 

2 Click VAIO Action Setup Help.

Programmable Power Keys

Your Sony computer is equipped with technology that allows you to get to your 
favorite applications easily. Each Programmable Power Key (PPK) on your VAIO 
Convertible keyboard comes programmed to launch a preset application with a 
single press of the key. If you wish, you can use VAIO Action Setup to change 
the PPK functions.

The Programmable Power Keys are located at the right side of your keyboard, 
and are numbered P1 through P4. The keys work even when the computer is 
turned off. Pressing one of these keys turns on the computer and launches the 
preset application.
21
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The four Programmable Power Keys perform by default the functions listed in 
the table below.

���
#��"���#�� �����" ��;��#��))� 

1 From the start menu, point to Programs, point to VAIO Action Setup, and 
then click VAIO Action Setup.

2 Click the PPK you want to change.

3 From the Select Application dialog box, click the radio button for the desired 
type of function. The corresponding applications appear in the list box on the 
right.

4 The Confirmation Application Name window appears showing you the 
application you have selected. Click Next

5 The Input Application name window appears. You can type a new name and 
description, if desired. Click Finish.

Internal Timer

The VAIO Action Setup software allows you to set your computer’s internal 
timer to launch certain applications automatically. 

��: ,
�
����

P1 (MAIL) Starts Microsoft® Outlook® Express.

P2 (INTERNET) Starts Microsoft® Internet Explorer for Windows Me.

P3 (PICTURE) Starts Sony’s PictureGear™.

P4 (HELP) Starts VAIO Demo/Help.
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Presetting i.LINK® Devices
Presetting i.LINK® Devices
You can preset your i.LINK-equipped devices to perform desired functions, such 
as automatically starting DVgate™ applications or connecting two VAIO 
computers.

���-�� ���:�
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1 From the Start menu, select Programs > VAIO Action Setup > VAIO Action 
Setup. 

The VAIO Action Setup windows appears.

2 Click i.LINK.

3 Click the Advanced Setting tab.

4 Click the Enable i.LINK launcher function checkbox and click Apply.

5 Connect the device to your computer with your i.LINK cable.

6 Turn on the device.

The VAIO Action Setup dialog box appears.

7 Click OK.

8 To modify the device name, click the current device name in the list box and 
click Modify device name.

9 Type the desired name and click Apply.

10 To assign an application, click Modify.

The Select Application dialog box appears.

11 Select the desired application and click Next.

12 Click Next to confirm the application name.

The Input Application Name dialog box appears. You may change the name 
and description of the application you want to launch.

13 Click Finish to complete this step.
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The next time the device is connected and turned on, the assigned application will 
launch automatically.

Changing the Window Design of Sony Software

���
#��"���#��*����*��� �"�

1 Click the Start button, point to Settings, and then point to Control Panel.

2 Click UI Design Selector.

3 Click << or >> and select the desired design.

4 Click Apply.

5 The “UI Design Selector” window design changes. The window design for 
your Sony software will match the “UI Design Selector” window.

6 To try another selection, click << or >> and then click OK.

7 The UI Design Selector closes and the Sony software window design 
displays.

AutoAlert E-mail Notification System

VAIO Action Setup also enables you to set up your computer to notify you with 
an Information LED when new mail arrives in your e-mail mailbox. The 
Information LED turns red to indicate that new e-mail has arrived. For this 
AutoAlert E-mail Notification System to work, you must use Microsoft® 
Outlook® Express as your default e-mail software, and you must have an Internet 
Service Provider with dial-up capabilities set up.

As an alternative, you can program your AutoAlert E-mail Notification System to 
set the Information LED to turn on when it has successfully completed the task of 
dialing up and connecting to receive mail. In this case, the Information LED turns 
on to indicate that your e-mail account has been accessed successfully, regardless 
of whether or not you have mail; this works with Microsoft Outlook Express.
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Presetting i.LINK® Devices
See “LCD Overview”  for an illustration showing the Information LED’s 
location.

AutoAlert E-mail Notification System Software Restrictions

�;�:�
�
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❑ The computer may not be able to disconnect the phone line due to 
communication and server conditions.

❑ Monitor the status of the software when running the AutoAlert E-mail 
Notification System, and manually disconnect the phone line if you notice a 
malfunction. When using the timer to start the software, set the computer to 
shut down or enter system standby mode after a certain length of time. This 
allows the computer to disconnect the phone line if the computer does not 
disconnect the line normally.

�;�:�
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❑ Set up your e-mail software to redial automatically if it does not connect the 
first time.

❑ Set up your e-mail software to disconnect the phone line automatically when 
all mail has been downloaded.
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Using the Memory Stick® Media 
Your VAIO Slimtop™ computer is designed to support the new Memory Stick 
recording media. The Memory Stick media is a compact, portable, and versatile 
device designed for exchanging and sharing digital data with compatible 
products.

You can use VAIO Action Setup to preset your computer to automatically launch 
an application when you insert a Memory Stick.
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Memory Stick media contains a write-protect tab. The write-protect tab prevents 
accidental changes to information recorded on the Memory Stick media. When 
you slide the write-protect tab to the LOCK position, the Memory Stick is 
write-protected, which means you cannot delete, copy, or save information on the 
Memory Stick. When you slide the tab to the un-LOCK position, you can write to 
or modify the Memory Stick contents. 

Inserting the Memory Stick Media
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Insert with Memory Stick facing this direction 
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Using the Memory Stick® Media
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Change the options on the Memory Stick tab in the PPK Setup software.

VisualFlow™

VisualFlow is a state-of-the-art Sony multimedia browser designed specifically 
for Memory Stick media. It displays any still picture, movie or sound files stored 
in a Memory Stick media in a visually pleasing, artistic manner. VisualFlow not 
only plays a selected movie or sound file, but also enables playback of files by 
other applications like PictureGear, Memory Stick Slideshow and Windows 
Explorer.

���
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1 From the Start menu, point to Programs > VisualFlow > VisualFlow.

2 Click on an icon in the View section on the main toolbar to select a display 
layout.

3 Click on an icon in the Sort section on the main toolbar to select a sorting 
method.

4 Resting your cursor on the left end of the main toolbar activates the current 
Memory Stick properties.

Locking the Memory Stick
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LOCK LOCK

To unlock To lock
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5 Resting your cursor on the right end of the main toolbar activates a 
secondary toolbar with more functions.

6 Click an image to show a normal view centered on the screen.

❑ Double-click an image to show an enlarged view.

7 Movie files start playback when the view is enlarged. Click again on movie 
files to restore the view to normal.
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Using PC Cards
Using PC Cards
This computer has a card bus PC card slot that supports a Type I or Type II PC 
cards.

����� ������)������

1 Slide front panel cover in the direction of arrow as shown in picture to open it.

2 Insert the PC card into the PC card slot until it clicks into position.

✍ '��������
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Opening the Front Panel (PCV-LX700/PCV-LX800)

Inserting a PC Card (PCV-LX700/PCV-LX800)

Insert with card facing this direction
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To Eject a PC Card

1 From the Start menu, point to Settings, and then point to Control Panel.

2 Click the PC card icon.

3 Click the name of the card that you want to eject, and then click Stop.

4 When the message “You may safely remove this device” appears, click OK.

5 Push the PC card eject button on the front panel of the system unit. You may 
need to pull the eject button out from the computer before you can eject the 
card.
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Using PC Cards
When the PC card is ejected from the card connector, remove the card by holding 
the edges and pulling it out carefully.

Ejecting a PC Card (PCV-LX700/PCV-LX800)
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Sony Digital Media Park 
Applications
Your VAIO computer comes with a collection of applications that make it easy to 
use advanced multimedia formats. This section describes the Digital Media Park 
applications and the digital video capabilities.

Media Bar™
Media Bar software is your all-in-one solution for audio/video playback. Media Bar 
software handles all common computer multimedia formats, and controls certain Sony 
devices. Media Bar software encompasses audio/video library cataloging and playlist 
management, in addition to digital video quality control and effects features. Media Bar 
seamlessly integrates a variety of new media formats with an easy-to-use software 
interface.

DVgate™
DVgate makes it easy to edit digital videos. You can grab and edit digital video clips, and 
then assemble them into a polished home video everyone will enjoy. You can also use 
DVgate to capture individual frames from digital video clips, and then save them as 
graphic files. Enhance your Web page, send family and friends your favorite stills, create 
your own wallpaper—the possibilities are endless. 

PictureGear™ 
PictureGear is a digital image management application that allows you to see all the 
images stored in any directory on your computer. Thumbnail views provide quick 
reminders of your pictures. Brighten, contrast, enhance, resize, crop, and color-correct 
your pictures. Create panoramic views, animations, screen savers, wallpaper, and even 
HTML photo albums. 

Smart Capture
Smart Capture is a fun new way to send multimedia messages via e-mail. Smart Capture 
manages the i.LINK® connection between your computer and a Sony Digital Handycam 
Camcorder, or other cameras that support the i.LINK interface. Smart Capture allows you 
to capture and compress video or still images that you can save or share via e-mail. 
Captures are low resolution, making it ideal for e-mail. For high-quality captures, use 
DVgate.
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Movie Shaker
This application can be used to create fun and innovative movies without any 
knowledge of film editing. In a few simple steps, motion pictures can be 
combined with special effects, still images (pictures), and music files and then 
saved in a format most computers can play. 

Importing Images and Sound Clips

1 Click .

2 Find the file you want to add.

3 Select the file.

4 Click Open. The file is added to the Clip tray.

Create a Movie using Shaker

After adding clip(s) to the Clip tray, you can create a short movie using the 
Shaker feature. Shaker randomly select clips from the Clip tray to create a 
30-second scene. 

Main Window
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Clip tray

Working Panel

Product tray

Editing trays

Help

Trash
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Movie Shaker
1 Click the Shake tab.

2 Select a mood by clicking a face in the Shaker tray.

3 Click . A thirty second scene is automatically generated and 
saved to the Product tray. 

4 To preview, switch the Work Panel to Product tray mode and press play.

Shaker tray
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Editing Clips and Scenes

You can edit your movie by adding effects and text, adjusting the color and 
contrast, and modifying the length of clips.
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1 Double-click the clip or scene to move it to the Working Panel.

2 Select the Effects tab from the Editing tray.

3 Drag and drop the Effect you want to add from the Effects tray to the Effects 
palette on the Working Panel.

4 See help for instructions on adjusting effect duration and replaying 
clips/scenes.

Working Panel
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Sound

Color

Speed

Effect Palette

Trim Palette

Monitor

Effect Knobs
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PictureGear™
Saving a Movie

1 Verify that the clip(s) you want to save is on the Product tray. See Help for 
more details on saving movies.

2 Click Export.

3 Select the format in which you want the document to be saved.

4 Click Next.

5 Locate the folder to which you want the file saved.

6 Name the file.

7 Click Save.

PictureGear™
PictureGear is a digital image management application that allows you to see all 
the images stored in any directory on your computer. Thumbnail views provide 
quick reminders of your pictures. Brighten, contrast, enhance, resize, crop, and 
color-correct your pictures. Create panoramic views, animations, screen savers, 
wallpaper, still pictures from MPEG, and even html photo albums.

Managing Your Pictures

Use the collection feature to manage your pictures. 

1 Click the Folder tab and browse to locate your pictures.

2 Select the pictures you want to have in a collection.

3 From Collection menu, select Create New Collection.

4 Enter a name for the collection and then click okay.
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Creating a Photo Album

1 Select the pictures you want to use to make an album.

2 From the Utilities menu, select Album Maker.

3 Choose the type of Album you want and click Okay.

4 Now add more pictures, frames, text, and effects.

5 When you are finished, select Create Album in File menu or click the Create 
Album icon on the toolbar.

6 Designate the folder you where want to save the Album.

7 Enter the Target Album name, select Thumbnails and click Okay.

8 The new album can be viewed using most internet browsers.

Using Panorama Maker

Panorama Maker stitches a group of still images into a 360 degree panoramic 
picture. The source images should be the same size and overlap 20%.

How to stitch a panoramic picture:

1 Gather the source images into the same folder or collection.

2 Select the images you want to use.

3 From the Utilities menu select Panorama Maker.

4 Select the correct lens and click Okay. (If 35mm lens is selected the prompt, 
does not appear; to select a different lens, click the lens icon.)

5 Click the panoramic icon, near the bottom of the window.

6 Click Full Stitch.

Making Still Images and Panoramic from MPEG

1 Select the MPEG file.

2 From the Movie/Sound menu, select Scene break down.

3 Then select Movie Stitch, to create a panoramic picture.
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Using a Digital Video Camera Recorder
Using a Digital Video Camera Recorder

Connecting a Digital Video Camera Recorder

Before connecting a digital video camera recorder to your computer, turn off the 
power on the camera. After connecting the camera, turn the power back on. You 
do not need to turn off the computer when connecting a camera.

Using DVgate™
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❑ Do not use DVgate when the connected digital video device is in Timer 
Recording mode, as this could produce a malfunction in the device.

❑ Captures larger than 2 GB (9 minutes and 30 seconds) are automatically 
continued in a second file.

❑ You can record stereo audio (stereo 1) while capturing video. You cannot add 
audio on the stereo 2 track after capturing the video data. 

❑ You cannot use different audio modes on the same tape. You should perform 
a separate capture for each audio mode you wish to use. 

❑ DVgate does not support hard disk compression. You should not use disk 
compression if you are planning to work with DVgate.

❑ Title data is saved in the flash memory of a digital video camera and is not 
transferred to tape by DVgate. 

❑ To avoid interruption of capture sessions, you should disable the screen 
saver.

❑ The drop frame compensation feature does not provide accurate 
compensation adjustments for tapes recorded in LP mode.

❑ For tapes that include a mixture of both SP and LP mode, the information 
displayed by the capture progress indicator may not be accurate.

❑ Make sure the video head of your digital video device is properly cleaned. 
Anomalies that you see in captured data could be due to dust or other 
particles on the video head.

❑ The last frame captured is one frame before your selected [OUT] point. The 
frame you see immediately after clicking the [OUT] button is not captured.
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❑ Do not use DVgate when the connected digital video device is in Timer 
Recording mode, as this could produce a malfunction in the device.

❑ To avoid recording problems, such as a single frame appearing in multiple 
frames, close other applications on your system while recording. 

❑ You cannot use different audio modes on the same tape. If you have AVI files 
that use different audio modes, they cannot be recorded at the same time, but 
must be recorded separately.

❑ Do not attempt to work with AVI files that are smaller than 4 MB.

❑ DVgate does not support hard disk compression. Do not use disk 
compression if you are planning to work with DVgate.

❑ In order to maximize recording capabilities, video and audio data are not 
available while you are recording.

❑ If DVgate indicates that frames have been dropped, close all open 
applications, or defragment your hard drive.
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Configuring your VAIO Slimtop™ 
LCD Computer
Hard Drive Partition
In order to improve the performance of the DVgate software, the hard disk drive 
on your computer has been formatted with two partitions, C and D. The DVgate 
software saves files to the D partition. This prevents large video captures from 
consuming the available space on your C partition. To maintain optimum DVgate 
performance, you should defragment your D partition regularly. 

Defragmenting your Hard Disk Drive
If you encounter frame dropping while recording digital video onto your hard 
disk drive, defragmentation may be necessary.
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1 Deactivate your screen saver, if applicable.

2 From the Start menu, select Programs > Accessories > System Tools > Disk 
Defragmenter.

3 Run Disk Defragmenter.
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i.LINK® (IEEE1394) Compatibility
Your VAIO computer includes a 4-pin i.LINK connector on the front of the 
system and a 6-pin i.LINK connector on the back of the system.

A 6-pin i.LINK connector can:

❑ supply power from the computer to the connected device if the device is 
equipped with a 6-pin connector, and

❑ supply 10V to 12V.

A 4-pin i.LINK connector cannot supply power to a connected device.

The following Sony i.LINK 400 Mbps cables are available and recommended 
for use with your computer: VMC-IL4415, VMC-IL4435, VMC-IL4615, 
VMC-IL4635, VMC-IL6615, and VMC-IL6635. Sony computer supplies, 
accessories, and peripherals can be purchased from your local retailer or by 
contacting Sony VAIO® Direct Web site (http://vaio.sonystyle.com), or by 
calling 1-888-315-7669 (toll free).
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❑ Use the  symbol to locate the i.LINK connector. Plug the i.LINK cable 
into this connector.

Connecting an i.LINK (IEEE1394) Device (PCV-LX700/PCV-LX800)
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i.LINK cable (optional)
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Enabling Ethernet
Your computer comes with a preinstalled Ethernet interface. To enable faster 
startup, your computer ships with this function disabled. You may enable 
Ethernet connectivity by following the instructions below.
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1 Right-click My Computer on the desktop and select Properties.

2 Click the Device Manager tab.

3 Select “SiS 900 PCI Fast Ethernet Adapter” under the Network Adapters 
category.

4 Click Properties.

5 Click Enable Device and then click OK.

6 Click Close.
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System and Application 
Recovery CD(s)
System Recovery CD(s)
Sony Electronics
The System Recovery CD program allows you to restore the software titles that shipped 
with your computer if they become corrupted or are erased. It can be used only to restore 
the hard disk of the Sony computer you purchased.

Application Recovery CD(s)
Sony Electronics
The Application Recovery CD program allows you to reinstall individual applications and 
device drivers. Use it to restore corrupted or erased files.

Using the System Recovery CD(s) 
You can reinstall software titles that shipped with your computer if they are 
corrupted or accidentally erased. You may not need to recover the entire contents 
of your hard drive. If you experience a problem with your computer, reinstalling 
an individual device driver or software title may correct the problem. 
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❑ Full Restore without Format — restores all the software titles that 
originally came with your computer without formatting the hard disk.

❑ Full Restore with Format — formats the hard disk drive and then restores 
all the original software. If your hard drive is partitioned into C and D drives, 
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the computer will offer you the option to reformat the drive into a single 
partition.
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1 Insert the Sony System Recovery CD in the CD-RW drive.

2 Shut down your computer.

3 Wait 30 seconds and turn on your computer.

4 Click OK to signify you have read and accept the Microsoft End-User 
License Agreement.

5 When the System Recovery menu appears, follow the on-screen instructions 
to complete the recovery process.
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Using the Application Recovery CD(s)
Using the Application Recovery CD(s)
The Application Recovery CDs allow you to reinstall individual applications and 
device drivers if they become corrupted or are accidentally erased. Reinstalling 
an individual device driver or software title may correct a problem you are 
experiencing with your computer, and you may not need to recover the entire 
contents of your hard drive.

You must be in Windows to run the Application Recovery CD(s). The application 
will not run from DOS. If you have any questions on using the Application 
Recovery CD(s), contact Sony Customer Support.
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1 Turn on your computer. If your computer is already on, close all 
applications.

2 When the Windows desktop appears, insert the Sony Application Recovery 
CD in the CD-RW drive. The Application Recovery utility loads 
automatically.

3 When the Application Recovery menu appears, follow the on-screen 
instructions to complete the recovery process.
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Troubleshooting
This section describes how to solve common problems you may encounter when 
using your computer. Many problems have simple solutions, so try these 
suggestions before you call Sony Customer Support. 

Topics

Topic: My computer does not start

❑ Check that the computer is plugged into a power source and that it is turned 
on. Check that the power light is lit on the front panel of the computer.

❑ Confirm that a diskette is not in the diskette drive (unless you are using a 
bootable diskette).

❑ Confirm that the power cord and all cables are connected firmly, as described 
on the color poster.

❑ If you plugged the computer into a power strip or Universal Power 
Supply (UPS), make sure the power strip or UPS is turned on and working.

❑ Check that the display is plugged into a power source and turned on. Check 
that the brightness and contrast controls are adjusted correctly. See the 
manual that came with your display for details.

❑ Check that the computer is not in standby mode.

Topic: My files are corrupted or deleted and I want to recover applications or 
drivers that came with my computer

See “Using the Application Recovery CD(s)” on page 47 in this manual.

Topic: My computer or software program stops responding

1 Press Ctrl+Alt+Delete to close the application that has stopped responding

2 In the Close Program dialog box, scroll down until you locate the message 
“Not responding” next to an application.
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3 Select this application and click End Task. Windows attempts to close the 
application. If the attempt is unsuccessful, a second dialog box appears.

4 Select End Task again.

❑ If you are unable to “unlock” the application, repeat the above steps but 
select Shut Down when the Close Program dialog box appears.

❑ If the above steps fail to “unlock” your computer, try the following steps:

1 Save any unsaved work, if possible. 

2 Press Alt+F4.

3 Select Restart.

4 Click OK.

❑ If you cannot restart as described in the preceding steps, you can restart the 
computer by pressing Ctrl+Alt+Delete or by pressing the power switch for 
more than six seconds.

❑ Contact the software publisher or designated provider for technical support. 
See the contact information in this manual.

Topic: Windows® Millennium Edition operating System locks up during 
shutdown

The Windows Me operating system may not shut down properly for many 
reasons, including incompatible or conflicting drivers, damaged files, or 
non-responsive hardware. For troubleshooting information, you can search 
Windows Help.

1 From the Start menu, select Help.

2 Click the Contents tab.

3 Click Troubleshooting and then click Windows Me Troubleshooters.

4 Click the subject for which you want information, and then answer the 
questions that are appropriate for your problem.

5 When the desired setting displays, press the Escape key.
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Topics
Topic: My CD-RW drive tray does not open

❑ Use the eject button

1 Make sure the computer is turned on.

2 Press the Eject button on the drive.

❑ Use the My Computer icon

1 Click the My Computer icon on the Windows® desktop.

2 Right-click the CD-RW icon.

3 Select the Eject option from the pop-up menu.

Topic: I cannot play a CD

❑ After inserting your CD, wait a few seconds for it to be detected before 
trying to access it.

❑ Make sure you place the disc in the tray with the label side facing up.

❑ Make sure the software is installed according to the program’s instructions.

❑ If your drive reads some CDs, but not others, check the shiny side of the disc 
for dirt or scratches. You may also need to clean the disc drive lens with an 
appropriate cleaner.

Topic: I want to play a CD with my Microsoft CD Player

When you insert a music CD, the Sony Media Bar™ automatically launches to 
play your CD. When the Sony Media Bar is running, the Microsoft CD Player 
does not have access to the CD. Close Media Bar to use the Microsoft CD Player. 
If you do not hear any music, check all your volume controls. 

Topic: When I click an application icon, a message such as “You must insert 
the application CD into your drive” appears and the software does not start

❑ Some titles require specific files that are located on the application’s CD. 
Insert the disc and try starting the program again.

❑ Check to make sure you inserted the CD with the label side facing up.

Topic: Why doesn't my CD-RW drive record at the highest speed?

You must use 8x CD-R or 4x CD-RW media to achieve optimum performance.
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If you must use other media and are having difficulty formatting non-4x CD-RW 
media, change the write speed from 4x to a lower setting. To change the write 
speed from the default to a lower speed:

1 Click the My Computer icon on your desktop.

2 Right-click the CD-RW drive icon.

3 Select Properties.

4 Select the Settings tab.

5 Change the “Current Write Speed” field to 2x.

6 Click OK.

Topic: How do I change the video resolution of my display?

1 From the Start menu, select Settings > Control Panel.

2 Click the Display icon and select the Settings tab.

3 Move the Display area slider to change the resolution.

4 Click OK.

Topic: Why is there no sound in any application?

There are independent controls for your system volume. 

❑ Check that the speakers are plugged into the HEADPHONES connector.

❑ If the speakers have a mute button, make sure it is off.

❑ If the speakers are powered by batteries, check that the batteries are inserted 
properly and that they are charged.
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✍ Your CD-RW drive is assigned drive G: as its default.

✍ 1X writing is not supported.
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❑ If the speakers use an external power source, make sure that the power cord 
is plugged into a grounded wall outlet or power strip.

❑ If the speakers have their own volume control, check the volume level.

❑ If the program you are using has its own volume control, check that the 
volume is turned up.

❑ Check the volume controls in the application, in the audio mixer, and in 
Windows. There is a volume control  on the Windows® taskbar. Click the 
icon and slide the level bar up to increase the volume.

❑ Check that the Mute check box is not selected in the Windows volume 
control . 

❑ If you connected headphones to the computer, you will not hear sound from 
the speakers. 

Topic: My modem connection is slow

The computer’s modem uses Lucent technology/V.90. Many factors influence 
modem connection speed, including telephone line noise or compatibility with 
telephone equipment (such as fax machines or other modems). If you think your 
modem is not connecting properly to other PC-based modems, fax machines, or 
your Internet Service Provider, check the following: 

❑ Have your phone company check that your phone line is free from any line 
noise.

❑ If your problem is fax-related, check that there are no problems with the fax 
machine you are calling and that it is compatible with fax modems.

❑ For optimum performance, ensure you are calling an Internet Service 
Provider number that is V.90-compliant.

❑ If you are having a problem connecting with your Internet Service Provider, 
check that the ISP is not experiencing technical problems.

❑ If you have a second phone line available, try connecting the modem to this 
line.

Topic: My modem does not work

❑ Check that the phone line is plugged into the LINE jack.

❑ Check that the phone line is working. You can check the line by plugging in 
an ordinary phone and listening for a dial tone.

❑ Check that the phone number the program is dialing is correct.
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❑ Verify that the software you are using is appropriately configured to 
recognize and interact with the Sony computer modem. Call the software 
publisher if you do not know how to configure the software to recognize the 
modem. All programs preinstalled by Sony are compatible.

❑ If you suspect your modem is not functioning, you can perform a simple test 
to find out. 

1 Click the My Computer icon on your desktop.

2 Click Control Panel.

3 Click Modems.

4 Click the Diagnostics tab.

5 Select COM3.

6 Click More Info.

If your modem is functioning, a More Info dialog box will display. If your 
modem is not functioning, an error message will appear.

Topic: How do I change my modem to rotary or Touch-Tone dialing?

1 Click the My Computer icon on your desktop.

2 Click Control Panel and then click Modems.

3 Click Dialing Properties.

4 Select the Tone dial or Pulse dial radio button next to “Dial using.”

5 Click OK.

Topic: My microphone does not work

Check that the microphone is plugged into the MIC connector. 

Topic: My microphone is too sensitive to background noise

If you find there is too much background noise when you record sound, you 
should adjust the microphone gain by following these steps:
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1 Right-click the speaker icon (Volume) in the lower-right Windows® task 
tray.

2 Click Open Volume Controls.

The Volume Control screen appears.

3 In the Options menu, select Properties.

The Properties screen appears.

4 Change the setting for “Adjust volume for” from Playback to Recording, 
then click OK.

5 Decrease the microphone level.

6 If available, click the Advanced button under Microphone Balance.

The Advanced Controls for Microphone screen appears.

7 Deselect the check box for 1 Microphone Boost, then click the Close button.

8 Close the Recording Control window.

Topic: My mouse does not work

❑ Check that the mouse is plugged into the MOUSE connector on the 
keyboard.

❑ There may be dust or dirt inside the mouse mechanism. To clean the mouse, 
follow these steps:

1 Turn off your computer and turn the mouse upside down.

2 Remove the mouse ball cover on the back of the mouse by turning 
clockwise the ring that covers the mouse ball.

3 Turn the mouse upright, and drop the mouse ball into your hand.

4 Using a piece of tape, remove any dust or dirt on the mouse ball and 
inside the mouse ball socket.

5 Return the mouse ball to the socket, and replace the mouse ball cover. 
Secure the cover by turning the ring counter-clockwise.
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Topic: My mouse needs to be set up for left-hand use

1 Click the My Computer icon on your desktop.

2 Click Control Panel, and then click Mouse.

The Mouse Properties dialog box appears.

3 In the Quick Setup tab, click Device Setup.

4 In the Device Setup Wizard dialog box, click Next.

5 Select the radio button next to “Left side of the keyboard.”

6 Click Next three times, and then click Finish.

7 Click Apply.

Topic: My keyboard does not work

Check that the keyboard is plugged into the KEYBOARD connector. 

Topic: I cannot find the Windows® taskbar

❑ Check that the taskbar is not hidden or shrunken.

❑ Use the mouse to point to the left, right, top, and bottom edges of the screen.

Topic: Why is my system running slowly?

❑ The system responsiveness varies depending on the number of applications 
that are open and running. Close any applications that you are not currently 
using.

❑ Increasing the system memory may also help. The computer has two 
memory slots. For memory upgrades, use only 3.3V 64-bit PC-133 SDRAM 
DIMM modules. For information on installing memory, please see the online 
manual, Upgrading and Maintaining Your VAIO® Computer.

Topic: My i.LINK® device does not appear on the desktop

1 Turn off and disconnect your device.

2 Reconnect your device.

3 Then turn on the power. 
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Topic: My connected printer doesn't function after the computer resumes from 
a power saving mode

When this occurs, follow the procedures below to reset the printer connection:

1 Right-click the My Computer icon on the desktop, and then select 
Properties.

2 Click the Device Manager tab.

3 Select Refresh, and then click OK.

4 The printer should now function properly.

Topic: How do I enable my Ethernet interface?

1 Right-click My Computer on the desktop and select Properties.

2 Click the Device Manager tab.

3 Select “SiS 900 PCI Fast Ethernet Adapter” under the Network Adapters 
category.

4 Click Properties.

5 Click Enable Device and then click OK.

6 Click Close.

Topic: How do I install a printer?

1 From the Start menu, select Settings > Printers.

2 Click Add Printer.

3 Click Next.
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4 Select Local Printer and click Next.

5 Select the appropriate manufacturer and model and click Next.

6 Select the appropriate port, and then click Next.

7 Click Yes to have Windows-based programs use this as the default printer.

8 Click Next.

9 Click No and then click Finish.

To Reach Sony 

For Sony PC Support, call 1-888-4SONYPC (1-888-476-6972) or access the 
Web site at: http://www.sony.com/pcsupport.
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Notes on Use
Notes on Use

On the Power Source

❑ Your computer operates on 100–120 V AC 50/60 Hz only. If you are 
operating this computer outside of North America or Japan, please verify 
that the local AC specifications match before plugging in the computer.

❑ The total power draw of installed add-in cards must not exceed the 
specifications for the power supply. Do not overload the system by installing 
add-in cards that draw excessive current. The system is designed to provide 
2 amps (average) of 5V power for each card in the system not to exceed a 
total of 10 amps. The total from +5V current draw in a fully-loaded system 
(with all the add-in card slots filled) must not exceed 10 amps. If you add 
components to the system that draw current from the power supply, the 
maximum combined +3.3V and +5V output must not exceed 70 watts.

❑ Plug all the power cords for your computer and its peripheral equipment into 
the same AC supply line. AC derived from different supply lines may result 
in voltage differences that can cause unstable operation or unwanted weak 
currents at the time of connection.

❑ Do not share the AC outlet with any other power-consuming equipment, 
such as copying machines or shredders.

❑ You can purchase a power strip with a surge protector. This device prevents 
damage to your computer caused by sudden power surges such as those that 
may occur during an electrical storm.

❑ If you live in an area that experiences frequent power fluctuations, you may 
want to purchase a UPS (Uninterrupted Power Supply). This device contains 
both a surge protector and a battery backup. The surge protector prevents 
damage to your computer caused by power surges. The battery backup 
safeguards your data during a brief period of power loss.

❑ The power control button on the front panel does not turn off the system 
AC power. To remove power from the system, you must shut down the 
computer as described in the User Guide and then unplug the AC power cord 
from the wall outlet or power strip.

❑ Do not place heavy objects on the power cord.

❑ Do not operate the system with the cover removed. Always reinstall the 
cover before turning on the system.

❑ To disconnect the cord, pull it out by the plug. Never pull the cord itself.
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❑ Unplug your computer from the wall outlet if you will not be using the 
computer for a long time.

❑ Before touching anything inside the computer, turn the system off and let it 
cool for ten minutes. This will ensure that the processor heat sink will not be 
hot. 

❑ Do not attempt to open the power supply. There are no user-serviceable parts 
in the power supply. To avoid personal injury or damage to your equipment, 
refer the repair or replacement of the power supply to qualified personnel 
only.

On Disposal of the Lithium Battery

Dispose of the lithium battery properly. In some areas, the disposal of lithium 
batteries in household or business trash may be prohibited. You can return your 
unwanted lithium batteries to your nearest Sony Service Center or Factory 
Service Center. For the Sony Service Center nearest you, call 1-888-4SONY-PC 
(1-888-476-6972).

On Handling the Computer System

❑ Do not place your Sony computer in a location subject to:

❑ Heat sources, such as radiators or air ducts

❑ Direct sunlight

❑ Excessive dust

❑ Mechanical vibration or shock

❑ Strong magnets or speakers that are not magnetically shielded

❑ Ambient temperature of more than 95ºF (35ºC) or less than 50ºF (10ºC)

❑ High humidity, moisture, or rain

❑ Do not place electronic equipment near your computer. The computer’s 
electromagnetic field may cause a malfunction.
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Notes on Use
❑ Provide adequate air circulation to prevent internal heat build-up. Do not 
place your computer on loose surfaces (such as rugs or blankets) or near 
materials (such as curtains or draperies) that may block its ventilation slots. 
Leave a space of at least 8 inches from the back panel of your computer.

❑ Clean the cabinet with a soft, dry cloth or a soft cloth lightly moistened with 
a mild detergent solution. Do not use any type of abrasive pad, scouring 
powder, or solvent such as alcohol or benzine, as it may damage the finish of 
your Sony computer.

❑ Should any solid object or liquid fall into the cabinet, keyboard, or mouse, 
shut down your computer and then unplug it. You may want to have the 
computer checked by qualified personnel before operating it any further.

❑ The computer uses high-frequency radio signals and may cause interference 
to radio or TV reception. Should this occur, relocate the computer a suitable 
distance away from the set.

❑ Use only specified peripheral equipment and interface cables; otherwise, 
problems may result.

❑ Do not use cut or damaged connection cables.

❑ Always switch the power off before connecting your computer to peripheral 
equipment; otherwise, damage may occur to the integrated circuits in your 
computer.

❑ Your computer, keyboard, and mouse consist of high-precision electronic 
parts. Do not drop them or bump them against other objects.

❑ Your Sony computer will not work with party lines, cannot be connected to a 
coin-operated telephone, and may not work with multiple phone lines or a 
private branch exchange (PBX).

❑ If the telephone company makes a service call to your home or office and 
determines that your computer is responsible for the problem, the telephone 
company may bill you for the service call. Also, if you do not disconnect 
your computer when it is adversely affecting the telephone line, the 
telephone company has the right to disconnect your service until you correct 
the problem.
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On Moisture Condensation

If your computer is brought directly from a cold location to a warm one, moisture 
may condense inside your computer. In this case, allow at least an hour before 
turning on your computer. If any problem occurs, unplug your computer, and 
contact your Sony Service Center.

On Upgrading the System

❑ The procedures described in the online manual, Upgrading and Maintaining 
Your VAIO® Computer assume familiarity with the general terminology 
associated with personal computers and with the safety practices and 
regulatory compliance required for using and modifying electronic 
equipment.

❑ Disconnect the system from its power source and from any networks, 
modems, or telecommunications links before you open the system or follow 
any of the procedures described in the online manual, Upgrading and 
Maintaining Your VAIO® Computer. Failure to do so may result in personal 
injury or equipment damage.

❑ Electrostatic discharge (ESD) can damage disk drives, add-in cards, and 
other components. Follow the procedures described in the online manual, 
Upgrading and Maintaining Your VAIO® Computer, only at an ESD 
workstation. If such a station is not available, do not work in a carpeted area, 
and do not handle materials that produce or hold static electricity 
(cellophane wrappers, for example). Ground yourself by maintaining contact 
with an unpainted metal portion of the chassis while performing the 
procedure.

❑ When removing a slot cover, be careful not to damage components on the 
system board or add-in cards. You may need to temporarily remove add-in 
cards that are next to the slot cover you want to remove.

On Handling an LCD Display

❑ Do not leave the LCD directly facing the sun for a long period of time as it 
can damage the LCD. 

❑ Do not scratch the LCD or exert pressure on it. This could cause 
malfunction.
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❑ Using the computer in low temperature conditions may produce a residual 
image on the screen. This is not a malfunction. When the computer returns to 
normal temperature, the screen returns to normal.

❑ A residual image may appear on the screen if the same image is displayed 
for a lengthy period of time. The image disappears after a period of time. 
You can use a screen saver to prevent residual images.

❑ The screen becomes warm during operation. This is normal and does not 
indicate a malfunction.

❑ The LCD is manufactured using high-precision technology. You may, 
however, see tiny black points and/or bright points (red, blue, or green) that 
continuously appear on the LCD. This is a normal result of the 
manufacturing process and does not indicate a malfunction.

On Handling a CRT Display

❑ Do not place the display near a strong magnetic force.

❑ Do not block the ventilation slots on the display.

On Using the Hard Disk Drive

❑ Do not place the computer in a location that is subject to vibration or shock.

❑ Do not move the computer during operation.

❑ Do not subject the computer to sudden changes in temperature.

❑ Do not turn off the power while the computer is accessing the hard disk 
drive.

On Handling Diskettes

❑ Do not open the shutter manually and touch the surface of the diskette.

❑ Keep diskettes away from magnets.

❑ Keep diskettes away from direct sunlight and other heat sources.

On Handling CD Media 

❑ Do not touch the surface of the disc.

❑ Do not drop or bend the disc.
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❑ Do not use adhesive labels to identify the disc. The label may come off while 
the disc is in use in the optical drive.

On Cleaning CD Media

❑ Fingerprints and dust on the surface of a disc may cause read errors. Proper 
care of the disc is essential to maintain its reliability. Do not use solvents 
such as benzine, thinner, commercially available cleaners or anti-static spray, 
as they may cause damage to the disc.

❑ For normal cleaning, hold the disc by its edge and use a soft cloth to wipe the 
surface from the center out.

❑ If the disc is badly soiled, moisten a soft cloth with water, wring it out well, 
and use it to wipe the surface of the disc from the center out. Wipe off any 
remaining moisture with a dry soft cloth.
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Resources
Sony provides several support options for your Sony computer. When you have 
questions about your computer and the preinstalled software, check these sources 
for answers, in the following sequence:

?
�
&������� Contains information on how to set up your computer 
quickly and easily.

<9�����0-
����

2 ���@
���

The User Guide (this manual) contains information on 
how to get the most from your computer, find help, and 
solve common problems. Also includes product 
specifications.

��!����4�!�
�����
5�

��

0��������

QuickStart and the User Guide are available electronically 
on your hard drive. Two additional guides, “Upgrading and 
Maintaining Your Slimtop™ LCD Computer”  and the 
Troubleshooting Help are also available online. To access 
online documentation, click the Start button, point to Help 
Center, and then point to the desired document.
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�! �������!����#�!-�

;�!� ��#���0�:�

�

�0-��:�:�
��
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 �;�*���

Most manuals for preinstalled software are located on your 
hard disk drive as online help files. You can access online 
help files from the Help menu in a specific application. 
A printed manual is available for some applications.

<9����
--����9"��� VAIO Support Agent can be accessed from the Windows 
desktop. Using advanced diagnostic technology, Sony’s 
VAIO Support Agent runs scheduled protections of your 
applications, network settings, and other important 
software settings. When your software is protected, you 
can use VAIO Support Agent to repair software problems 
by restoring your software to any of the previously 
protected states.

���*!��"�������� � Provides instant access to information on commonly 
encountered problems. Enter a description of your problem 
and the Knowledge Database searches for the 
corresponding solutions online. You can access the Sony 
Knowledge Database at http://www.sony.com/pcsupport
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���:�,�A������0��� This service provides you with answers to commonly 
asked questions. You can use this automated service to 
request a list of available topics and then select the topics 
that you want to receive. To contact the Sony 
fax-on-demand service, call 1-888-4SONYPC 
(1-888-476-6972). (Requires a fax machine or fax 
software.)

��;�*����2-���� You can download the latest software updates and software 
patches for your Sony computer by selecting Software 
Updates on the Sony PC Support web page at 
http://www.sony.com/pcsupport

<9�����0-
����

��;����
�����
�!

Provides detailed technical information about your 
computer's hardware. This document is available from 
Sony's website at http://www.sony.com/pcsupport
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For Answers to Your Software Questions

Sony Service Center

For the Sony Service Center nearest you, call 1-888-4SONYPC 
(1-888-476-6972). This service is free of charge for 90 days after the original 
date of purchase.

Acrobat® Reader, Adobe PhotoDeluxe® Home Edition, Adobe Premiere® 
LE (Adobe Systems Incorporated)

America Online® (America Online)

CompuServe® 2000 (CompuServe Interactive Services)

DirectCD, Easy CD Creator™ (Adaptec, Inc.)

Web site http://www.adobe.com/

phone 206-628-2746 (fee-based support)

fax 206-628-5737

e-mail techdocs@adobe.com

hours M - F, 6 AM - 5 PM PT

Web site http://www.aol.com/

phone 800-827-6364

hours 7 days a week, 24 hours a day

Web site http://www.compuserve.com/

phone 800-848-8990

hours M - F, 8 AM - 1 AM, Sat - Sun, 10 AM - 10 PM

Web site http://www.adaptec.com/

phone 408-945-8600

hours M - F, 8AM - 5 PM PT
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EarthLink TotalAccess™(EarthLink Network, Inc.)

McAfee VirusScan® (Network Associates, Inc.)

Netscape® Communicator (Netscape Communications, Corp.)

PhotoPrinter™ 2000 Pro (ArcSoft, Inc.)

Quicken® 2000 Basic (Intuit, Inc.)

Sony Applications (Sony Electronics, Inc.)

Web site http://help.earthlink.net/techsupport/

phone 800-395-8410

e-mail support@earthlink.net

hours 7 days a week, 24 hours a day

Web site http://support.mcafee.com 

phone 408-988-3832 

e-mail cybr@nai.com 

hours M - F, 9 AM - 5 PM CT

Web site http://help.netscape.com

phone 888-4SONYPC (888-476-6972)*

* Support from 1-888-4SONYPC is free of charge for 90 days after the original date of purchase.

hours 7 days a week, 24 hours a day

Web site http://www.arcsoft.com
http://www.photoisland.com

phone 510-440-9901

e-mail techsupport@arcsoft.com

hours M - F, 8:30 AM - 5:30 PM PT

Web site http://www.intuit.com/support/

phone 900-555-4688

hours 7 days a week, 24 hours a day

Web site http://www.sony.com/pcsupport

phone 888-4SONYPC (888-476-6972)*

hours 7 days a week, 24 hours a day
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Windows® Millennium Edition Operating System, Internet Explorer, 
Outlook® Express, Word 2000 (Microsoft Corporation)

* Support from 1-888-4SONYPC is free of charge for 90 days after the original date of purchase.

Web site http://www.sony.com/pcsupport

phone 888-4SONYPC (888-476-6972)*

* Support from 1-888-4SONYPC is free of charge for 90 days after the original date of purchase.

hours 7 days a week, 24 hours a day
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Specifications PCV-LX700/PCV-LX800
Specifications
PCV-LX700/PCV-LX800

����! )�<�7B+11 )�<�7B.11

)��
�  �� 733 MHz* Intel® Pentium® III 800EB MHz Intel® Pentium® III

%������ &������

��=���)���������

49--��A�0���5

20 GB†

C = 8 GB / D = 12 GB
40 GB

C = 16 GB / D = 24 GB

������������9� 64‡ MB PC-133 SDRAM, 
expandable to 512MB

128** MB PC-133 SDRAM, 
expandable to 512MB

<������9� Shared with system memory

@��-#�
 SiS 630 graphics hardware acceleration 

��
�����-���!���� SiS 630 (AC97 Compliance)

����������� 32X max. CD-ROM reading,
8X max. CD-R writing, 

32X max. CD-R reading,
4X max. CD-RW writing,

20X max. CD-RW reading††

����0 Lucent 1648 technology/V.90 compatible data/fax modem 
(REN 0.7)‡‡

�A-�� ����

��-���!���� 

Two PCI slots 

�����
�����

��-���!���� �4,����5

PC card slot (Card bus support)
USB port (1)

Memory Stick® media slot
i.LINK® (4-pin) port

�����
�����

��-���!���� �4����5

USB ports (3)
Modem line jack (RJ-11)
Phone line jack (RJ-11)

CRT Display
LCD display
Headphones
Microphone

Line In
i.LINK (6-pin) port

10Base-T/100Base-TX Fast Ethernet LAN jack (RJ-45)
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Specifications are subject to change without notice.

�����
�����

��-���!���� �

47����� -!�:5

Mouse port
PS/2® Keyboard port

USB port

�
--!����

9

�  ���� 

PS/2 Wheel Mouse
VAIO Convertible Keyboard and palmrest

Power cord
Modem cable

�����
� 90-day limited service. See Warranty Card.***

7�0������������: 90-day parts/labor standard. See Warranty Card.†††

)�*�����C
���0��� 145 watts maximum

��0�� ��� CPU: 11” (h) x 4.2” (w) x 14.5” (d) 
(280 mm x 107 mm x 370 mm)

Keyboard with palmrest: 17.1” (w) x 2” (h) x 8” (d) 
(435 mm x 51 mm x 205 mm)

LCD Display: 17.1” (w) x 14” (h) x 6.4” (d)
(435 mm x 357 mm x 163 mm)

���"#� CPU: 14.3 lbs. (6.5 kg)
Display: 12.1lbs.(5.5 kg) 

Keyboard: 2.2 lbs. (1.0 kg)

�-������"�

��0-����
��

50º F to 95º F (+10º C to 35º C)

* MHz denotes microprocessor internal clock speed; other factors may affect application performance.
† GB means one billion bytes when referring to hard drive capacity. Accessible capacity may vary.
‡ 64 MB available. 16 MB allocated to video RAM.
**128 MB available. 16 MB allocated to video RAM.
††The CD-RW/CD-R/CD-ROM data transfer standard 1X rate is 150 kbytes/s. 

Data on a CD-RW is read at a variable transfer rate, ranging from 8X at the innermost track to 20X 
at the outermost track. The average data transfer rate is 14X(2100 kbytes/s).
Data on a CD-R/CD-ROM is read at a variable transfer rate, ranging from 13X at the innermost track 
to 32X at the outermost track. The average data transfer rate is 22.5X(3375 kbytes/s).
Data on a CD-RW/CD-R is written at a constant transfer rate of 1X, 2X, 4X (max for CD-RW), or 
8X depending on the speed you select. 

‡‡Maximum speed for faxing is 14.4 kbytes/s. Your modem is capable of downloading at 
56 kbytes/s using K56flex technology or V.90. Your phone service, online service, or Internet 
Service Provider may not support this technology or operate at this speed. 

***Certain restrictions apply.
†††Certain restrictions apply.

����! )�<�7B+11 )�<�7B.11
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Index
A
AC input connector 16
adding additional hardware

precaution 60
adjusting voltage settings 59
air circulation 61
Application Recovery CD 45,
47
applications

launching
problems with 51

B
battery

disposing 60
brightness control, on LCD 18

C
cables 61
CD-RW drive 13
CD-RW drives

troubleshooting 51
CD-RW tray

opening
problems with 51

choosing locations 11
cleaning

computer 60

mouse 55
computer

adjusting voltage settings 59
cleaning 60
condensation and 62
disposing of battery 60
lithium ion battery 7
removing cover 59
shutting down 59
starting

problems with 49
upgrading 62

connectors
power cords 59
precautions 61

customer assistance
support options 65

D
disconnecting power cords 59
diskettes

handling 63
displaying the taskbar

problems with 56
displays

problems with 49
setting up 12

disposal of lithium ion battery 7
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E
electronic

documentation 65
equipment 60

European power settings 59

G
glare 12

H
handling diskettes 63
hard disk 63
hardware

adding additional
precaution 60

troubleshooting 49, 56
headphones connector 17
help 65

I
Information LED, on LCD 18
input devices

setting up 11
installing additional hardware

precaution 60
interference 61

K
keyboard 11

troubleshooting 56

L
launching applications

problems with 51

LCD
adjusting 19
connector 17

line jack 16
lithium ion battery

disposal 7
safety precautions 7

locations, choosing 11
losing power 59

M
Memory Stick media

slot 15
using 26

microphones
troubleshooting 54

minimizing glare 12
modem

troubleshooting 53
monitor connector 17
mouse 11

cleaning 55
troubleshooting 55

O
online

help 65
support options 65

opening
applications

problems with 51
CD-RW tray

problems with 51
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Index
P
palmrest 11
PC (PCMCIA) card, using 29
PC card slot 15
phones

service precautions 61
PictureGear 33
power cords 59

disconnecting 59
power fluctuations or loss 59
power indicator

on LCD 18
power source, precautions 59–
60
printer connector 17
problem solving 49
Programmable Power Keys
(PPK), using 21

R
radio interference 61
reducing glare 12
removing computer cover 59

S
screens, reducing glare 12
serial connector 17
Shaker 35
shutting down your computer
59
Sony Fax-on-Demand service
66
Sony Multimedia Computer

Display
problems with 49
setting up 12

Sony Online Support
options 65

speakers
precaution 60

starting your computer
problems with 49

surge protectors 59
system

troubleshooting 49
System Recovery CD 45

T
taskbar

problems viewing 56
technical support

support options 65
telephone jack 17
troubleshooting 49
turning off your computer 59
turning on your computer

problems with 49
TV interference 61

U
Universal Serial Bus (USB)
connector 15, 17
upgrading your computer 62
UPS (Uninterrupted Power
Supply) 59
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V
VAIO Action Setup 21
ventilation 11, 61
viewing the taskbar

problems with 56
voltage settings 59
volume control, on LCD 18

W
window design of Sony
software 24
Windows taskbar

problems viewing 56
work surfaces 11
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	Welcome
	Thank you for purchasing your Sony VAIO Slimtop™ LCD computer! Your new computer is a superb blen...
	Choosing an Ergonomic Location for Your Computer
	Stable work surface
	Ventilation
	Placement of the keyboard, mouse, and other input devices
	Furniture and posture
	Viewing angle of the display
	Lighting

	Front Panel Overview
	Locating Controls and Connectors
	Front Panel (PCV-LX700/PCV-LX800)
	PCV-LX700/PCV-LX800 Front Panel (cont.)


	Back Panel Overview
	Locating Controls and Connectors
	Back Panel (PCV-LX700/PCV-LX800)


	LCD Overview
	LCD Monitor
	Adjusting the LCD display
	1 Holding both sides of the display, push the display panel out and up.
	Adjusting the Height and Viewing Angle of the Display
	2 Set the display height so that it does not touch the keyboard, and adjust the viewing angle app...

	Adjusting Viewing Angle





	VAIO® Action Setup
	VAIO Action Setup manages the settings for your computer's Programmable Power Keys (PPK), interna...
	To access VAIO Action Setup Help:
	1 Click Start, point to Programs, and then point to VAIO Action Setup.
	2 Click VAIO Action Setup Help.

	Programmable Power Keys
	To change the settings of the PPKs
	1 From the start menu, point to Programs, point to VAIO Action Setup, and then click VAIO Action ...
	2 Click the PPK you want to change.
	3 From the Select Application dialog box, click the radio button for the desired type of function...
	4 The Confirmation Application Name window appears showing you the application you have selected....
	5 The Input Application name window appears. You can type a new name and description, if desired....


	Internal Timer
	Presetting i.LINK® Devices
	To preset your i.LINK device to perform a desired function
	1 From the Start menu, select Programs > VAIO Action Setup > VAIO Action Setup.
	2 Click i.LINK.
	3 Click the Advanced Setting tab.
	4 Click the Enable i.LINK launcher function checkbox and click Apply.
	5 Connect the device to your computer with your i.LINK cable.
	6 Turn on the device.
	7 Click OK.
	8 To modify the device name, click the current device name in the list box and click Modify devic...
	9 Type the desired name and click Apply.
	10 To assign an application, click Modify.
	11 Select the desired application and click Next.
	12 Click Next to confirm the application name.
	13 Click Finish to complete this step.

	Changing the Window Design of Sony Software
	To change the window design
	1 Click the Start button, point to Settings, and then point to Control Panel.
	2 Click UI Design Selector.
	3 Click << or >> and select the desired design.
	4 Click Apply.
	5 The “UI Design Selector” window design changes. The window design for your Sony software will m...
	6 To try another selection, click << or >> and then click OK.
	7 The UI Design Selector closes and the Sony software window design displays.


	AutoAlert E-mail Notification System
	AutoAlert E-mail Notification System Software Restrictions
	If you use software that uses a phone line
	If you are using the timer to download e-mail automatically



	Using the Memory Stick® Media
	Inserting the Memory Stick Media
	To protect data on Memory Stick media from accidental changes
	Locking the Memory Stick

	To change the way the computer responds when a Memory Stick is�inserted into the Memory Stick med...
	VisualFlow™
	To use VisualFlow
	1 From the Start menu, point to Programs > VisualFlow > VisualFlow.
	2 Click on an icon in the View section on the main toolbar to select a display layout.
	3 Click on an icon in the Sort section on the main toolbar to select a sorting method.
	4 Resting your cursor on the left end of the main toolbar activates the current Memory Stick prop...
	5 Resting your cursor on the right end of the main toolbar activates a secondary toolbar with mor...
	6 Click an image to show a normal view centered on the screen.
	7 Movie files start playback when the view is enlarged. Click again on movie files to restore the...



	Using PC Cards
	To Insert a PC Card
	1 Slide front panel cover in the direction of arrow as shown in picture to open it.
	Opening the Front Panel (PCV-LX700/PCV-LX800)
	2 Insert the PC card into the PC card slot until it clicks into position.

	Inserting a PC Card (PCV-LX700/PCV-LX800)
	To Eject a PC Card

	1 From the Start menu, point to Settings, and then point to Control Panel.
	2 Click the PC card icon.
	3 Click the name of the card that you want to eject, and then click Stop.
	4 When the message “You may safely remove this device” appears, click OK.
	5 Push the PC card eject button on the front panel of the system unit. You may need to pull the e...
	Ejecting a PC Card (PCV-LX700/PCV-LX800)



	Sony Digital Media Park Applications
	Your VAIO computer comes with a collection of applications that make it easy to use advanced mult...
	Media Bar™
	DVgate™
	PictureGear™
	Smart Capture
	Movie Shaker
	Main Window
	Importing Images and Sound Clips
	1 Click .
	2 Find the file you want to add.
	3 Select the file.
	4 Click Open. The file is added to the Clip tray.


	Create a Movie using Shaker
	1 Click the Shake tab.
	2 Select a mood by clicking a face in the Shaker tray.
	Shaker tray
	3 Click . A thirty second scene is automatically generated and saved to the Product tray.
	4 To preview, switch the Work Panel to Product tray mode and press play.



	Editing Clips and Scenes
	Working Panel
	Adding effects to a scene or a clip
	1 Double-click the clip or scene to move it to the Working Panel.
	2 Select the Effects tab from the Editing tray.
	3 Drag and drop the Effect you want to add from the Effects tray to the Effects palette on the Wo...
	4 See help for instructions on adjusting effect duration and replaying clips/scenes.


	Saving a Movie
	1 Verify that the clip(s) you want to save is on the Product tray. See Help for more details on s...
	2 Click Export.
	3 Select the format in which you want the document to be saved.
	4 Click Next.
	5 Locate the folder to which you want the file saved.
	6 Name the file.
	7 Click Save.



	PictureGear™
	Managing Your Pictures
	1 Click the Folder tab and browse to locate your pictures.
	2 Select the pictures you want to have in a collection.
	3 From Collection menu, select Create New Collection.
	4 Enter a name for the collection and then click okay.


	Creating a Photo Album
	1 Select the pictures you want to use to make an album.
	2 From the Utilities menu, select Album Maker.
	3 Choose the type of Album you want and click Okay.
	4 Now add more pictures, frames, text, and effects.
	5 When you are finished, select Create Album in File menu or click the Create Album icon on the t...
	6 Designate the folder you where want to save the Album.
	7 Enter the Target Album name, select Thumbnails and click Okay.
	8 The new album can be viewed using most internet browsers.


	Using Panorama Maker
	1 Gather the source images into the same folder or collection.
	2 Select the images you want to use.
	3 From the Utilities menu select Panorama Maker.
	4 Select the correct lens and click Okay. (If 35mm lens is selected the prompt, does not appear; ...
	5 Click the panoramic icon, near the bottom of the window.
	6 Click Full Stitch.


	Making Still Images and Panoramic from MPEG
	1 Select the MPEG file.
	2 From the Movie/Sound menu, select Scene break down.
	3 Then select Movie Stitch, to create a panoramic picture.



	Using a Digital Video Camera Recorder
	Connecting a Digital Video Camera Recorder
	Using DVgate™
	When capturing clips
	When recording AVI files to tape




	Configuring your VAIO Slimtop™ LCD Computer
	Hard Drive Partition
	Defragmenting your Hard Disk Drive
	To defragment your hard disk drive
	1 Deactivate your screen saver, if applicable.
	2 From the Start menu, select Programs > Accessories > System Tools > Disk Defragmenter.
	3 Run Disk Defragmenter.


	i.LINK® (IEEE1394) Compatibility
	To connect an i.LINK (IEEE1394) device
	Connecting an i.LINK (IEEE1394) Device (PCV-LX700/PCV-LX800)


	Enabling Ethernet
	To enable the Ethernet connection
	1 Right-click My Computer on the desktop and select Properties.
	2 Click the Device Manager tab.
	3 Select “SiS 900 PCI Fast Ethernet Adapter” under the Network Adapters category.
	4 Click Properties.
	5 Click Enable Device and then click OK.
	6 Click Close.



	System and Application Recovery CD(s)
	System Recovery CD(s)
	Sony Electronics

	Application Recovery CD(s)
	Sony Electronics

	Using the System Recovery CD(s)
	The System Recovery utility options
	Full Restore without Format
	Full Restore with Format

	To use the System Recovery CD(s)
	1 Insert the Sony System Recovery CD in the CD-RW drive.
	2 Shut down your computer.
	3 Wait 30 seconds and turn on your computer.
	4 Click OK to signify you have read and accept the Microsoft End-User License Agreement.
	5 When the System Recovery menu appears, follow the on-screen instructions to complete the recove...


	Using the Application Recovery CD(s)
	To use the Application Recovery CD(s)
	1 Turn on your computer. If your computer is already on, close all applications.
	2 When the Windows desktop appears, insert the Sony Application Recovery CD in the CD-RW drive. T...
	3 When the Application Recovery menu appears, follow the on-screen instructions to complete the r...



	Troubleshooting
	This section describes how to solve common problems you may encounter when using your computer. M...
	Topics
	Topic: My computer does not start
	Topic: My files are corrupted or deleted and I want to recover applications or drivers that came ...
	Topic: My computer or software program stops responding
	1 Press Ctrl+Alt+Delete to close the application that has stopped responding
	2 In the Close Program dialog box, scroll down until you locate the message “Not responding” next...
	3 Select this application and click End Task. Windows attempts to close the application. If the a...
	4 Select End Task again.
	1 Save any unsaved work, if possible.
	2 Press Alt+F4.
	3 Select Restart.
	4 Click OK.
	Topic: Windows® Millennium Edition operating System locks up during shutdown

	1 From the Start menu, select Help.
	2 Click the Contents tab.
	3 Click Troubleshooting and then click Windows Me Troubleshooters.
	4 Click the subject for which you want information, and then answer the questions that are approp...
	5 When the desired setting displays, press the Escape key.
	Topic: My CD-RW drive tray does not open
	1 Make sure the computer is turned on.
	2 Press the Eject button on the drive.
	1 Click the My Computer icon on the Windows® desktop.
	2 Right-click the CD-RW icon.
	3 Select the Eject option from the pop-up menu.

	Topic: I cannot play a CD
	Topic: I want to play a CD with my Microsoft CD Player
	Topic: When I click an application icon, a message such as “You must insert the application CD in...
	Topic: Why doesn't my CD-RW drive record at the highest speed?
	1 Click the My Computer icon on your desktop.
	2 Right-click the CD-RW drive icon.
	3 Select Properties.
	4 Select the Settings tab.
	5 Change the “Current Write Speed” field to 2x.
	6 Click OK.

	Topic: How do I change the video resolution of my display?

	1 From the Start menu, select Settings > Control Panel.
	2 Click the Display icon and select the Settings tab.
	3 Move the Display area slider to change the resolution.
	4 Click OK.
	Topic: Why is there no sound in any application?
	Topic: My modem connection is slow
	Topic: My modem does not work
	1 Click the My Computer icon on your desktop.
	2 Click Control Panel.
	3 Click Modems.
	4 Click the Diagnostics tab.
	5 Select COM3.
	6 Click More Info.

	Topic: How do I change my modem to rotary or Touch-Tone dialing?

	1 Click the My Computer icon on your desktop.
	2 Click Control Panel and then click Modems.
	3 Click Dialing Properties.
	4 Select the Tone dial or Pulse dial radio button next to “Dial using.”
	5 Click OK.
	Topic: My microphone does not work
	Topic: My microphone is too sensitive to background noise

	1 Right-click the speaker icon (Volume) in the lower-right Windows® task tray.
	2 Click Open Volume Controls.
	3 In the Options menu, select Properties.
	4 Change the setting for “Adjust volume for” from Playback to Recording, then click OK.
	5 Decrease the microphone level.
	6 If available, click the Advanced button under Microphone Balance.
	7 Deselect the check box for 1 Microphone Boost, then click the Close button.
	8 Close the Recording Control window.
	Topic: My mouse does not work
	1 Turn off your computer and turn the mouse upside down.
	2 Remove the mouse ball cover on the back of the mouse by turning clockwise the ring that covers ...
	3 Turn the mouse upright, and drop the mouse ball into your hand.
	4 Using a piece of tape, remove any dust or dirt on the mouse ball and inside the mouse ball socket.
	5 Return the mouse ball to the socket, and replace the mouse ball cover. Secure the cover by turn...

	Topic: My mouse needs to be set up for left-hand use

	1 Click the My Computer icon on your desktop.
	2 Click Control Panel, and then click Mouse.
	3 In the Quick Setup tab, click Device Setup.
	4 In the Device Setup Wizard dialog box, click Next.
	5 Select the radio button next to “Left side of the keyboard.”
	6 Click Next three times, and then click Finish.
	7 Click Apply.
	Topic: My keyboard does not work
	Topic: I cannot find the Windows® taskbar
	Topic: Why is my system running slowly?
	Topic: My i.LINK® device does not appear on the desktop

	1 Turn off and disconnect your device.
	2 Reconnect your device.
	3 Then turn on the power.
	Topic: My connected printer doesn't function after the computer resumes from a power saving mode

	1 Right-click the My Computer icon on the desktop, and then select Properties.
	2 Click the Device Manager tab.
	3 Select Refresh, and then click OK.
	4 The printer should now function properly.
	Topic: How do I enable my Ethernet interface?

	1 Right-click My Computer on the desktop and select Properties.
	2 Click the Device Manager tab.
	3 Select “SiS 900 PCI Fast Ethernet Adapter” under the Network Adapters category.
	4 Click Properties.
	5 Click Enable Device and then click OK.
	6 Click Close.
	Topic: How do I install a printer?

	1 From the Start menu, select Settings > Printers.
	2 Click Add Printer.
	3 Click Next.
	4 Select Local Printer and click Next.
	5 Select the appropriate manufacturer and model and click Next.
	6 Select the appropriate port, and then click Next.
	7 Click Yes to have Windows-based programs use this as the default printer.
	8 Click Next.
	9 Click No and then click Finish.

	To Reach Sony


	Notes on Use
	On the Power Source
	On Disposal of the Lithium Battery
	On Handling the Computer System
	On Moisture Condensation
	On Upgrading the System
	On Handling an LCD Display
	On Handling a CRT Display
	On Using the Hard Disk Drive
	On Handling Diskettes
	On Handling CD Media
	On Cleaning CD Media

	Resources
	For Answers to Your Software Questions
	Sony Service Center
	Acrobat® Reader, Adobe PhotoDeluxe® Home Edition, Adobe Premiere® LE (Adobe Systems Incorporated)
	America Online® (America Online)
	CompuServe® 2000 (CompuServe Interactive Services)
	DirectCD, Easy CD Creator™ (Adaptec, Inc.)
	EarthLink TotalAccess™(EarthLink Network, Inc.)
	McAfee VirusScan® (Network Associates, Inc.)
	Netscape® Communicator (Netscape Communications, Corp.)
	PhotoPrinter™ 2000 Pro (ArcSoft, Inc.)
	Quicken® 2000 Basic (Intuit, Inc.)
	Sony Applications (Sony Electronics, Inc.)
	Windows® Millennium Edition Operating System, Internet�Explorer, Outlook®�Express, Word�2000 (Mic...



	Specifications PCV-LX700/PCV-LX800
	PCV-LX700
	PCV-LX800
	733 MHz Intel® Pentium® III
	800EB MHz Intel® Pentium® III
	20 GB
	C = 8 GB / D = 12 GB
	40 GB
	C = 16 GB / D = 24 GB
	64 MB PC-133 SDRAM, expandable to 512MB
	128 MB PC-133 SDRAM, expandable to 512MB
	Shared with system memory
	SiS 630 graphics hardware acceleration
	SiS 630 (AC97 Compliance)
	32X max. CD-ROM reading, 8X�max. CD-R writing, 32X�max. CD-R reading, 4X max. CD-RW writing, 20X�...
	Lucent 1648 technology/V.90 compatible data/fax modem (REN 0.7)
	Two PCI slots
	PC card slot (Card bus support) USB port (1)
	Memory Stick® media slot
	i.LINK® (4-pin) port
	USB ports (3)
	Modem line jack (RJ-11)
	Phone line jack (RJ-11)
	CRT Display
	LCD display
	Headphones
	Microphone
	Line In
	i.LINK (6-pin) port
	10Base-T/100Base-TX Fast Ethernet LAN jack (RJ-45)
	Mouse port PS/2® Keyboard port
	USB port
	PS/2 Wheel Mouse
	VAIO Convertible Keyboard and palmrest
	Power cord
	Modem cable
	90-day limited service. See Warranty Card.
	90-day parts/labor standard. See Warranty Card.
	145 watts maximum
	CPU: 11” (h) x 4.2” (w) x 14.5” (d) (280 mm x 107 mm x 370 mm) Keyboard with palmrest: 17.1” (w) ...
	LCD Display: 17.1” (w) x 14” (h) x 6.4” (d)
	(435 mm x 357 mm x 163 mm)
	CPU: 14.3 lbs. (6.5 kg)
	Display: 12.1lbs.(5.5 kg) Keyboard: 2.2 lbs. (1.0 kg)
	50º F to 95º F (+10º C to 35º C)
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